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Genesys Knowledge Center Developer's Guide

Genesys Knowledge Center Developer's
Guide

Welcome to the Genesys Knowledge Center Developer’s Guide. This document provides information
about how you can integrate Knowledge Center for your website and environment. See the summary

of chapters below:

Integration Using Knowledge On your Web Site
Find out how Knowledge Center works Learn how to add Knowledge Center to
with other Genesys components. your web resources.

Integrating with Genesys Web Engagement Simple Integration for Pre-Production

Environment

Integration with Web

Find out more information on the User
Interface, including Knowledge Agent and
Widgets.

Sample Ul

Improving Contact Us Form
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Simple Integration for Pre-Production Environment

Simple Integration for Pre-Production
Environment

Overview

This chapter describes the integration steps that allows you to add Knowledge Center functionality to
your site without modifying any code. To configure the integration you need to use Proxy shipped with
Genesys Web Engagement product.

The GWM Proxy is a development tool that you use to add new functionality to a website without
directly modifying that site. Once you have configured this proxy, you can use the Genesys
Knowledge Center Sample Ul from any of your websites. In a few clicks, without modifying your
website, the Knowledge Center Sample Ul features shows up on a set of web pages, according to the
rules and categories that you created. There are two proxy tools available in the Web Engagement
installation, the Simple tool and the Advanced tool. Within this instruction you need to use the
Advanced GWM Proxy. For more information regarding proxy please refer to the Genesys Web
Engagement documentation.

GWE Proxy provides support for easy integration into existing sites within the pre-
production environment. It is not recommended to use it in a production environment.
Please use similar tools available on the market.

Configuring the Advanced GWM Proxy

The Advanced GWM Proxy is based on the OWASP Zed Attack Proxy Project (ZAProxy). In addition to
acting as a proxy, the Advanced GWM Proxy also provides a Ul and validates vulnerabilities in your
website at the same time.

The Advanced GWM Proxy requires JDK 1.7 or higher.

Before you start using the Advanced GWM Proxy, you need to carry out a few configuration
procedures.

Genesys Knowledge Center Developer's Guide 4
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Starting the Proxy

Navigate to your Web Engagement installation directory and launch either servers\proxy2\zap.bat (on
Windows) or servers\proxy2\zap.sh (on Linux).

The proxy starts.
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The Advanced GWM Proxy

Configuring the Proxy

Important

Below please find an example of integrating the Knowledge Widget via Proxy. The
sample source of the widget can be found here:
<knowledge _center_server_root>\server\tools\integrations\knowledgewidget

Once the proxy is running, you can configure it using the GUI.

Start

1. Open Tools > Filter....

Genesys Knowledge Center Developer's Guide 5
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Configuring the Proxy Filter

Select the Filter menu item.

2. In the list of filters, select Replace HTTP response body using multiple patterns and click ... to
edit the filter.
o
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Select the filter.
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3. Click Add.
4. Enter </head> in the Pattern: field of the resulting dialog box.
5. Enter the following code in the Replace with: field.

<link type="text/css" rel="stylesheet" href="http://
<link_to_resources>/gkc-knowledge-widget.min.css">
<script>
window. gkc = {
knowledge: {
host: 'http://<link to server>/gks-server/vl',
kbId: 'knowledgefaq',
customerId: 'gks super'

}I
events: {
windowOpenEvent: function (wdWindow) {
console.log(wdWindow) ;
}I
windowCloseEvent: function (wdWindow) {
console.log(wdWindow) ;
}I
windowHideEvent: function (wdWindow) {
console.log(wdWindow) ;
+
kbSelectEvent: function (kbId) {
console.log(kbId);
}!
searchEvent: function (query) {
console.log(query);
}!
documentOpenEvent: function (document) {
console.log(document);
}
}

};

window. gkcLocalization = {

title: 'Ask’',

inputPlaceholder: 'Ask a questions',

trendingMessage: 'Trending questions',

loading: 'Loading...',

noResultFound: 'No relevant results found',

feedback: {
question: 'Was this helpful?',
defaultAnswer: 'Thank you for your vote',
noCommentAnswer: 'Thank you for your vote',
submitAnswer: 'Thanks, your feedback has been submitted',
commentPlaceholder: 'Why wasn\'t this helpful?',

buttons: {
yes: 'Yes',
no: 'No',

submit: 'Submit',
noComment: 'No comment'

}
+i
</script>
<script src="http://<link to resources>/
gkc-knowledge-widget.min.js"></script>

6. Click OK to save the pattern.
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Entering a Filter Pattern

7. Click OK to save the pattern.

End

Configuring the URL Filter

Complete this procedure to use the GUI to configure URLs that the proxy should ignore.
Start

You can exclude a site in one of two ways:

Using the Sites Tab

1. In the Sites tab, right-click a site and select Exclude from > Proxy.
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Excluding a Site from the Proxy Filter

2. Select a site to exclude.

Using the File Menu

1. Select File > Properties. In the Session Properties window, select Exclude from proxy, add your
URL regular expression, and click OK. For example, to have the proxy include only the google.com
website, use this regular expression:

~((?'google.com).)*$
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Adding a Regular Expression for Ignoring Sites

2. Enter a URL to exclude.

If you want the proxy to remember the excluded URLs beyond the current session, select File >
Persist session... and select a file to save your session to.

End

Working with the Proxy

After you have configured the proxy, keep it open and configure the connection to the network via
the Proxy inside you browser. Now you can browse through the web pages that are instrumented with
the Knowledge Center Sample Ul, and they will be displayed in the Sites tab of the proxy GUI, as
shown here:
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Browsing Your Proxy Sites

For more information about working with ZAProxy, see https://www.owasp.org/index.php/
OWASP Zed Attack Proxy Project.
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Integrating with Genesys Web Engagement

Overview

When you integrate Knowledge Center with Genesys Web Engagement, you are giving your agents
access to important proactive engagement capabilities. Knowledge Center (and the way you interact
with) it allows you to better understand your customer needs and intentions. For example, monitoring
customer activities with Knowledge Center on the corporate web site allows you to find the right
moment to propose agent help when the customer appears to be lost. When such an interaction
appears on an Agent workspace, all the customer requests and browsing history are made available.
This is one of the many reasons why you might want to integrate Knowledge Center with Genesys
Web Engagement in your environment.

Tight integration between Knowledge Center and Web Engagement allows you to monitor customer
activities on your web site (both browsing and working with knowledge). It also defines customer
behavior patterns and actions that should take place when patterns occur (including both immediate
contact with an agent or postponed processing of the activity).

Here are some examples of the patterns you could look for and suggested reactions:

e Customer indicates that they cannot find the answer to the question. A suggested reaction for this
event is the chat option with the agent (how to configure such integration is shown in the example
below).

¢ A Premium customer has left negative feedback on one of the documents he viewed. A suggested
reaction for this event is a follow-up call to maintain the relationship with the customer.

e While browsing throughout the site a customer has expressed interest in establishing a new service with
the company. A suggested reaction for this event is to do a follow-up and check whether or not the
customer has successfully set-up the new service and then send a note of thanks for being a loyal
customer.

To integrate products in your environment you need to add Knowledge Center-specific events into the
Web Engagement DSL file which describes business events for a given website. All other steps are
standard for installation of Genesys Knowledge Center and Genesys Web Engagement.

Sample DSL

KnowledgeCenter.DSL provides a basic set of events that are used in your integration. Events are
based on the Sample Ul GUI shipped with the product.

DSL file contains following events:

* Open a category in browsing

Genesys Knowledge Center Developer's Guide 12
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Integrating with Genesys Web Engagement

¢ Viewing of search results
¢ Open document for viewing content
e Leaving positive and negative feedback

¢ Requesting additional help (no aster found)

Engaging chat with agent when no answer found

Follow the instructions below to configure this integration.

Start

1. Install and properly configure Genesys Web Engagement, using the GWE Deployment Guide.

2. Create a Knowledge Center application in GWE.

3. Create a DSL file that describes your site's business logic. You can either use the Intool provided with
GWE or use the standard DSL for the Sample Ul that is provided with Knowledge Center. Replace the
standard GWE content by the new DSL that is included at GWE root folden\apps\gks\_composer-project\

WebEngagement _EngagementWidgets\dsl\domain-model.xml.

Dl

G | Bewrch Enging Dptimizateon for ertiches oresied i the Genesys Heowieige Cemer CHET

5 W BN T SOOI OIS B O W S ATk SO — Iy e — b QLT B SRR foe ek

B 0 Bt Mt e Tewiee Pebin Sreee deis G 0005, Bl

v Comenia

GWE Integration Tool

Here is a sample DSL file:

<?xml version="1.0" encoding="utf-8"?>
<properties>
<events>
<event id="NoRelevantResults" name="GKnowledge">
<trigger name="NoResultsTrigger" element=
"DIV. gk- wd- rs-no-answer A" action="click" url="" count="1"/>
<val name="gks question" value="$
('#searchContent').val()"/>
<val name="gks kbId" value="'knowledgeFAQ'"/>
<val name="gks session" value=
"window.localStorage.getItem('sessionId')"/>
</event>
</events>
</properties>

sronim @ 0, -
LI A |

Genesys Knowledge Center Developer's Guide

13



Integrating with Genesys Web Engagement

. In Composer, modify the Web Engagement templates, which will be either
WebEngagement_CEPRule_Templates (if you use GRAT 8.1.3) or
WebEngagement_CEPRule_Templates_85 (if you use GRAT 8.5).

Add new event names to the Enums. In the above example, we used an event name of GKnowledge.

:f Package Evploser 2 EfR T=n 0 Ervurva [WiehEngugertenr_CEPRule_Ternplies #igic] & =
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Editing an Enum Value

5. Publish CEPRule_Templates to the GRS repository.
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Publishing a Project

6. Create a business rule based on your custom DSL and on CEPRule_Templates. For example:

rule "Rule-100 No Relevant Results"
salience 100000
agenda-group "levelQ"
dialect "mvel"
when
$eventl: Event(eval($eventl.getName()

.equals('NoRelevantResults')))
then

sendEvent ($eventl, ed, drools);
end
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7. Modify default.workflow in the WebEngagement_EngagementLogic Composer project.
Add new user variables, gks_kbld, gks_question, and gks_session, to the Entry ( Start ) block:

a si‘u:-.id_st 0 PROCESENg efrar-—4 Entry m:mi
of nteraction in case of el @ P 1 Syekaen vaniskes, |
error. This shoud prevent spectic {user-defin
us friom erdisss oo businessDecsion o

# Log

& Application Yariables

Set the application varnables

Set the applcation variables

Variable Name [ category [ vae | Deserigtion 2] aad |
system OrighatingSession  Systern  undafired The ariginating session conkext.

BackandURL User _data Backand AL value of Backand Server which works ... Aelgte |
BackendURLSecure Lser _daka, BackendURLSecure  Enter Description

ks _khid Lkzer = Eritar Descripkion L4 |
ghs _queeskion User Enter Descripkion

ks _sessian User Eriter Destription E' T |

(7 o | cm|

Adding New Variables

8. Add parsing for new variables to the ECMA Script ( ParseEvent ) block:

* -to parss the L] =
- : ‘% Paletbe
% ECMA Script =k bt ain EU"_I
tosave cste [ @ G-
ParseEvent wandsoon |
i b bt Lk,

& Expression Builder

Expression Builder
Build an expression in the Expression Field by seleding the operaton(s) and data ebement(s) from the categories

and subcategories below,
ook O R o R i
Copy Cut Paste Undo Redo Yalidate
fisld | cvpe fiter bt
VRN _CUSTOMETFTSINATIE = SYENILIACE, 3408, OUSTOMSTFTSIame; :l —
event_oustomerLastilame = eventData,data. cusbomerl asthanms; = [ Project variables ;I

event_nde = eventData,data.rule; B Jefheway i

ghe_KDEd = eventData data.ghs_kbld: el .“ie[ﬂ

gks_question = eventData. daba.ghks_guestion; 1 I | 4

ghs_sesson = eventDats dats. ghs_session;

event_engagements_in_progress = evertata, daka.engagements_in_progress; Irset I

event_sngagement_attempts = eventData, data. sngagement_atbempts;
event_sngagement_type = aventDaka,data,engagement_type;

}

ECMA Script for Event Parsing
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9. Add parsed data to the interaction
!

L User Data

BssigriData

1

in the User Data (AssignUData) block:
(@assignpata ___________H

Edit Assign Data
Selack the kery and vahoe.

o SR (5
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Add Parsed Data to Interaction

10. Save default.workflow and generate new SCXML strategies by clicking the Generate All button:
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=] B3

| 4% Composer

Generate All
I Generate Code For all the Diagram files
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¥ Generate Code for Diagram Files
¥ Create revision

™ Major Yersion (1.0.0)

™ Minor Yersion (0,1.0)

% Micro Yersion (0.0.8)
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: Caommenkt -
] 1 F

@:l Finish I Cancel

Generate SCXML Strategies
11. Build the Knowledge Center Server application (run build gks).

12. Deploy the Knowledge Center Server application (run deploy gks).

Modify the GWE backend Config Server application. Add new variables, gks_question, gks_kbld, and

13.
gks_session, to the wes.connector.interaction.copyUserData option.
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Add Options to GWE Backend Server

14. Deploy the business rule created in Step 6, above, to GWE storage.

15. Run the GWE servers.
End

To allow GWE to access the Knowledge Center Ul, you need to modify either your site or the Sample
Ul by adding a Web Monitoring Agent script similar to the following sample to the source code of your
web Ul application.

<script>
var gt = gt || [];
_gt.push(['config', {
dslResource : ('https:' == document.location.protocol
? 'https://<host>:<portl>' : 'http://<host>:<port2>")
+ '/server/resources/dsl/domain-model.xml",
httpEndpoint : 'http://<host>:<port2>"',
httpsEndpoint : 'https://<host>:<portl>'
s

var _genesys = {
chat: {
serverUrl: 'http://<host>:<port3>/backend/cometd’,
registration: true

}I
embedded: true,
onReady: []

¥

(function(d, s, id, o) {
var fs = d.getElementsByTagName(s)[0], e;
if (d.getElementById(id)) return;
e = d.createElement(s); e.id = id; e.src = o.src;
e.setAttribute('data-gcb-url', o.cburl);
fs.parentNode.insertBefore(e, fs);

}) (document, 'script', 'genesys-js', {
src:
"http://<host>:<port2>/server/resources/js/build/genesys.min.js",
1)
</script>

Genesys Knowledge Center Developer's Guide 18
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Important

To make the integration work, you need to run both the GWE backend and frontend
servers.

For more detailed instructions, refer to the GWE documentation.
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Sample Ul

Sample Ul

Overview

The Sample Ul is based on backbone.js and divided into three parts:

¢ Knowledge Agent — low level mapper that covers Knowledge APl and encapsulate Knowledge session
management.

location: gks-sample-ui.war/modules/knowledge_agent/

¢ Ul Widgets — atomic modules that responsible for key Ul elements (such as: search panel, search result

view, document view).
location: gks-sample-ui.war/modules/widgets/
e The Sample-Ul itself — combination of the first two and the logic of their interactions.

location: gks-sample-ui.war/

Sample Ul

Knowledge agent

Knowledge API

Sample Ul

Genesys Knowledge Center Developer's Guide
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Sample Ul

Templates Hierarchy

ey wakge]

Templates hierarchy and available widgets

Page Descriptions

According to Templates hierarchy there are five general page templates defined:

1. Home page — welcome page of Sample Ul.
Displays list of Top questions and associated categories.
routing: #
[+] Click here to expand sample

Search

Top questions

What are redemption codes and how do they work?

When and how will my goods arrive?

Do all Live events use G-Pass tickets?

Can | expedite shipping?

What's the difference between Flash Deals and Market Pick Hatels?

What else do | need to know at check-in far my Market Pick?

How to use the maobile app to redeem a Groupon

I want to book a hotel that | saw on Getaways recently, but now | can't find it. What happened?
[ think | gat charged twice

What happens if my Groupon voucher's promotional value expires?

Categories

Home Mortgage Tax Documents Buying

mabile services frequently asked questions Online check images Using a Groupon
Home Equity Basics Getting an auto loan Alerts

My Spending Report with Budget Watch
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2. Search result page — result of searching.
Displays relevant documents based on search query and associated to them categories.
routing: #category/:categoryld/search/:searchQuery
[+] Click here to expand sample

Search

What's a 401(k) plan?

A 401(k) plan is a tax-qualified retirement plan that allows emplayees (and business owners) to invest far retirement with pre-tax
contributions that defer part of their pay. A 401(k) plan may allow the employer to make tax-deductible contributions t... mare

Who can establish a 401(k) plan?

Any sole proprietor, partnership, corporation or subchapter S and certain nonprafit organizations can establish a 401(k) plan. State
and local governments are prohibited from adopting 401(k) plans, but there are other types of retirement plans that m... more

Must all employees contribute to the 401(k) plan?

Mo. While employees who are eligible to participate under the 401(k) plan must be given the right to participate, they are not
obligated to contribute to the plan. more

..

Categories

Home Mortgage Home Equity Basics Home Equity Rates & Services

3. Browsing page — categories browsing.
Displays documents in specific category and associated to them categories.
routing: #category/:categoryld/search/

4. Document page — full document info.
Displays full content of the specific document. In case of click directly after search, this page also
contains voting area and help button.
routing: #kbld/:kbld/document/:documentid
[+] Click here to expand sample
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Search

What is a rate lock?

A rate lock gives you protection from financial market fluctuations that could affect your interest rate range. You can choose to lock or not
lock your interest rate range. On the date and time you lock, that interest rate range remains available to you for a set period of time. If
there are no subsequent changes to your loan and your interest rate range is locked, the interest rate range on your application generally
remains the same. If there are changes to your loan, your final interest rate at closing may be different.

Whether | found it relevant— Yes / No

Categories

Home Mortgage Tax Documents
mobile services frequently asked questions Online check images
Home Equity Basics Getting an auto loan

My Spending Repart with Budgst Watch

5. Categories page — list of available categories.

| NEED MORE HELP

Buying
Using a Groupaon
Alerts

Displays all available categories and provides browsing capability for them.

routing: #categories
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Sample Ul Knowledge Agent

Knowledge Agent

Overview

Knowledge agent is an AMD-based module that can be used with RequireJS. It exports the gka
variable into the local context where it is accessed.

Configuration
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Sample Ul Knowledge Agent

_gka.initialize(options) Examples

Description: Configure the Knowledge agent.

* options
Type: PlainObject
A set of key/value pairs that configure the Agent.

* host

Type: String
A network host where Knowledge API is stored.

* kbid

Type: String
Knowledgebase default identifier to be used.

 knowledgebases

Type: String[] _gka.initialize({

Knowledgebases identifiers to be used host: 'http://localhost:8080"', .
knowledgebases: ['knowledgefaq', 'knowledgearticles']

* lang i3]

Type: String
Default language to be used.

* agentid

Type: String
Agent ID

¢ auth

Type: String
Agent ID

¢ customerid

Type: String

Genesys Knowledge Center Developer's Guide 25



Sample Ul Knowledge Agent

_gka.initialize(options) Examples

Customer ID

¢ authorization

Type: String
Basic authorization token

« media (default: 'chat')

Type: String
Default search filter by media channel type

¢ apiClientld (default: 'web')

Type: String
A web client identifier

¢ apiClientMediaType (default: 'selfservice')

Type: String
A web client media type
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Sample Ul Knowledge Agent

Knowledge Agent API

Once configuration is complete, the Agent can receive data from the Knowledge API. The _gka
variable contains the following interfaces:
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Knowledge Agent

Method
Knowledge Base Operations
.getknowledgeBases()
.getkKnowledgeBaselnfo()
.getCategories()
.getFullContent()
FAQ retrival
.search()
.getDocumentsByCategory()
.getTrending()
.suggestions()
Feedback
.noAnswer()
.vote()
.advancedVote()
.visit()
.rating()
.addRating()

Description

Retrieves list of knowledge bases supported

Retrieves information about the particular knowledge base

Retrieves list of categories

Retrieves full content of particular document

Executes search for the answer for the given query
Retrieves documents associated to a specific category

Retrieves trending documents
Provides autocomplete functionality

Marks query as the one that do not have valid answer in knowledge base

Records user rating for the document within query

Advanced version of .vote()

Registers viewing the document
Registers 5-star rating for the document
Adds rating feedback to an existing vote
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Sample Ul Knowledge Agent

Knowledge Base Operations

Important
For additional information, please refer to the Knowledge API page.
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Sample Ul

Knowledge Agent

_gka.getKnowledgeBases(): Promise

Description: Retrieves information about the particular knowledge base.

Response

* knowledgebases

Type: PlainObject[]
List of supported knowledgebases

°* name
Type: String
Name of knowledgebase

* languages
Type: String[]
List of supported languages

_gka.getKnowledgeBaselnfo([options]): Promise
Description: Retrieves information about the knowledge base.
* options

Type: PlainObject
A set of key/value pairs that contains arguments for the RESTful API.

e kbld (default: stored _gka.kbld)
Type: String
Particular knowledge base identifier.

Response

Example

_gkn.getKnowledgeBases () .done(function(response, status) {

console.log(response)

}).fail(function(error, status) {

1)

console.log(error)

"knowledgebases": [{
"name": "knowledgefaq",
"languages": [

nan®
1

Fo A
“name": "the bank",

"languages": [
nan™
1
1

Example

_gkn.getKnowledgeBaseInfo().done(function(response, status) {

console.log(response)

}).fail(function(error, status) {

1)

console.log(error)

Genesys Knowledge Center Developer's Guide

30


https://docs.genesys.com/Documentation/KC/latest/Developer/GKCKnowledgeAgent#Promise_Object
https://docs.genesys.com/Documentation/KC/latest/Developer/GKCKnowledgeAgent#Promise_Object

Sample Ul

Knowledge Agent

_gka.getKnowledgeBaselnfo([options]): Promise

* languages

Type: String[]
List of supported languages for given knowledgebase

_gka.getCategories(): Promise

Description: Retrieves list of categories.

Response

* categories

Type: PlainObject[]
List of supported categories

e id
Type: String
Category identifier

° name
Type: String
Category name

e count
Type: Number
Total count of documents in category

Example
{
languages: [
|en ] ,
1 frl ,
Idel
]
b
Example

_gkn.getCategories().done(function(response, status) {
console.log(response)

}).fail(function(error, status) {
console.log(error)

1)
{
"categories": [{
"id": "Home Mortgage",
“name": "Home Mortgage",
“count": 78
oA
"id": "Home Equity Basics",
"name": "Home Equity Basics",
“count": 78
H
}
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Sample Ul

Knowledge Agent

_gka.getFullContent(options): Promise

Description: Retrieves full content of particular document.

Example

e options
Type: PlainObject

A set of key/value pairs that contains arguments for the RESTful API.

* kblid
Type: String
Knowledge base identifier

e docld
Type: String
Particular document identifier.

Response

e id
Type: String

* language
Type: String

* typeName
Type: String

e kbid
Type: String

» categories
Type: String[]

* created
Type: Number

e modified
Type: Number

* snippet

_gkn.getFullContent({

docId: 'knowledge'

}) .done(function(response, status) {

console.log(response)

}).fail(function(error, status) {

console.log(error)

"id":"knowledge",
"language":"en",
"typeName":"gna document en",
"kbId":"knowledge",
"categories": [

"Booking trips"
Iy
"created":1402573911163,
"modified":1402573911163,
"snippet":"",
"fields":{

"id":"knowledge",

"created":1402573911163,

"answer":"Every travel option we offer",

"categories": [

"Booking trips"
] ’

"question":"What's the difference between",

"modified":1402573911163
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Sample Ul Knowledge Agent

_gka.getFullContent(options): Promise Example
Type: String
» fields
e id
Type: String
* created

Type: Number

e answer
Type: String

* categories
Type: String[]

e question
Type: String

¢ modified
Type: Number
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Sample Ul Knowledge Agent

FAQ retrival
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Sample Ul Knowledge Agent

_gka.search([options]): Promise Example
Description: Executes search for the answer for the given query.
* options

Type: PlainObject
A set of key/value pairs that contains arguments for the RESTful API.

e from (default: 0)
Type: Number

Pagination offset. _gkn.search({
from: 0O,

* size (default: 10) size: 10,

Type: Number query: '',

Pagination page size categories: []

}) .done(function(response, status) {

* query (default: ") console.log(response)

Type: String }).fail(function(error, status) {

User typed query string . console.log(error)

* categories (default: [1)
Type: String[]
List of categories that is used as a context for the current query

e filters
Type: String[]
List of filters

Response
+ count {
"count": 78,
Type: Number "page": {
“from": 0,
* page "size": 10
Type: PlainObject T,
"documents": [
e from {
Type: Number "id": "knowledge",
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Sample Ul

Knowledge Agent

_gka.search([options]): Promise

* size
Type: Number

e documents

Type: PlainObject[]
e id
Type: String

* language
Type: String

* typeName
Type: String

¢ kbid
Type: String

e categories
Type: String[]

e created
Type: Number

« modified
Type: Number

e snippet
Type: String

* score
Type: Number

e fields
Type: PlainObject

* question
Type: String

Example

"language": "en",
"typeName": "gna document en",
"kbId": "knowledge",
"categories": [
"Home Equity Basics",
"Home Mortgage"
]I
"created": 1404823845989,
"modified": 1404823845989,
"snippet": "What is the difference\n",
"score": 4.20981,

"fields": {
"question": "What is the difference",
"answer": "Locking ensures that you"

"morelikethis": [

]I
"confidence": 1.0

"id": "knowledge",
"language": "en",
"typeName": "gna document en",
"kbId": "knowledge",
"categories": [
"Home Equity Basics",
"Home Mortgage"
]l
"created": 1404823845989,
"modified": 1404823845989,
"snippet": "How long do I have to pay",
"score": 4.20981,

"fields": {
"question": "How long do I have",
"answer": "If you obtained your"

}I

"morelikethis": [
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Sample Ul

Knowledge Agent

_gka.search([options]): Promise
* answer
Type: String

¢« morelikethis
Type: String[]

¢ confidence
Type: Number

* categories
Type: PlainObject[]
e id
Type: String
° name
Type: String

e count
Type: String

_gka.getDocumentsByCategory(): Promise
Description: Retrieves documents associated to a specific category.

* options
Type: PlainObject

A set of key/value pairs that contains arguments for the RESTful API.

e kblid
Type: String
Knowledge base identifier
* catid

Type: Number
Category ID.

Example
Il
"confidence": 1.0
}
]I
"categories": [
{
"id": "Home Equity Basics",
"name": "Home Equity Basics",
“count": 78
}I
{
"id": "Home Equity Rates & Services",
"name": "Home Equity Rates & Services",
"count": 2
}

Example

_gka.getDocumentsByCategory ({
catId: options.categories[0]

}) .done(function(reponse) {
console.log(response)

}).fail(function (error, status) {
console.warn(error)

1)
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Sample Ul

Knowledge Agent

_gka.getDocumentsByCategory(): Promise

e from (default:0)
Type: Number
Pagination offset.

e size (default: 10)
Type: Number
Pagination page size

Response

* count

Type: Number(]

* page
Type: PlainObject

e from

Type: Number
¢ size

Type: Number

e documents
Type: PlainObject[]
e id
Type: String

* language
Type: String

 typeName
Type: String

¢ kbld
Type: String

Example
"count": 78,
"page": {
"from": 0,
"size": 10
}l
"documents": [
{
"id": "GBank 458",
"language": "en",
"typeName": "gna document en",

"kbId": "GBank",
"categories": [
"Home Equity Basics",
"Home Mortgage"
]I
"created": 1404823845989,
"modified": 1404823845989,
"snippet": "What is the difference\n",
"score": 4.20981,

"fields": {
"question": "What is the difference",
"answer": "Locking ensures that you"

"morelikethis": [

1,

Genesys Knowledge Center Developer's Guide

38


https://docs.genesys.com/Documentation/KC/latest/Developer/GKCKnowledgeAgent#Promise_Object

Sample Ul

Knowledge Agent

_gka.getDocumentsByCategory(): Promise

e categories
Type: String[]

e created
Type: Number

¢ modified
Type: Number

e snippet
Type: String

* score
Type: Number

e fields
Type: PlainObject

* question
Type: String

* answer
Type: String

* morelikethis
Type: String([]

* confidence
Type: Number

* categories
Type: PlainObject[]
e id
Type: String

° name
Type: String

}
] ’

Example
"confidence": 1.0
"id": "GBank 477",
"language": "en",
"typeName": "gna document en",

"kbId": "GBank",
"categories": [
"Home Equity Basics",
"Home Mortgage"
]I
"created": 1404823845989,
"modified": 1404823845989,
"snippet": "How long do I have to pay",
"score": 4.20981,

"fields": {
"question": "How long do I have",
"answer": "If you obtained your"
}I

"morelikethis": [

]I
"confidence": 1.0

"categories": [

{

"id": "Home Equity Basics",

"name": "Home Equity Basics",

"count": 78

"id": "Home Equity Rates & Services",
"name": "Home Equity Rates & Services",
"count": 2
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Sample Ul

Knowledge Agent

_gka.getDocumentsByCategory(): Promise

e count
Type: String

For additional information, please refer to the Knowledge API page.

_gka.getTrending([options]): Promise
Description: Retrieves trending documents.
* options

Type: PlainObject
A set of key/value pairs that contains arguments for the RESTful API.

* size (default: 10)
Type: Number
Pagination page size

Response

e count
Type: Number[]

e documents
Type: PlainObject
e id
Type: String

* language
Type: String

* typeName
Type: String

e kblid
Type: String

Example

Example

_gka.getTrending() .done(function(reponse) {
console.log(response)

}).fail(function (error, status) {
console.warn(error)

1)
{
"count": 78,
"documents": [
{
"id": "GBank 458",
"language": "en",
“"typeName": "gna document en",

"kbId": "GBank",
"categories": [
"Home Equity Basics",
"Home Mortgage"
]I
"created": 1404823845989,
"modified": 1404823845989,
"snippet": "What is the difference\n",
"score": 4.20981,
"fields": {
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Sample Ul Knowledge Agent

_gka.getTrending([options]): Promise Example

"question": "What is the difference",

 categories "answer": "Locking ensures that you"

Type: String[] ,
"morelikethis": [

e created
Type: Number 1,
« modified ) confidence": 1.0
Type: Number {'
. "id": "GBank 477"
* snippet 0 To TamD
. ; language": "en",
Type: String "typeName": "gna document en",
e score "kbId": "GBank",
. "categories": [
Type: Number "Home Equity Basics",
e fields : "Home Mortgage"
Type: PlainObject "Created": 1404823845989,
* question "modified": 1404823845989,
Type: String "snippet": "How long do I have to pay",
"score": 4.20981,
* answer "fields": {
Type: String "question": "How long do I have",
"answer": "If you obtained your"
¢ morelikethis } . con
Type: String[] morelikethis": [
» confidence 1, i e
Type: Number ] onfidence": 1.
. Iy
* categories i e
. . t :
Type: PlainObject[] ca ?gorles [
e id "id": "Home Equity Basics",
. . "name": "Home Equity Basics",
Type: String "count": 78
* name {
Type: String "id": "Home Equity Rates & Services",
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Sample Ul

Knowledge Agent

_gka.getTrending([options]): Promise
e count
Type: String

For additional information, please refer to the Knowledge API page.

_gka.suggestions(options): Promise
Description: Provides autocomplete functionality.

* options
Type: PlainObject

A set of key/value pairs that contains arguments for the RESTful API.

* query
Type: String
User typed query string.

e categories
Type: String
List of categories that are used as context for the query.

Response

* suggestions
Type: String[]

For additional information, please refer to the Knowledge API page.

Example
"name": "Home Equity Rates & Services",
“count": 2
b
]
¥
Example

_gkn.suggestions ({
query: ‘'ipad'

}) .done(function(response, status) {
console.log(response)

}).fail(function(error, status) {
console.log(error)

1)
{
"suggestions": [
"What else do I need to know at check-in",
"What is a Non-Sufficient Funds fee",
"What’'s a 401(k) plan?\n",
1
ks

Genesys Knowledge Center Developer's Guide

42


https://docs.genesys.com/Documentation/KC/latest/Developer/GKCKnowledgeAgent#Promise_Object
https://docs.genesys.com/Documentation/KC/latest/API/KnowledgeAPI
https://docs.genesys.com/Documentation/KC/latest/Developer/GKCKnowledgeAgent#Promise_Object
https://docs.genesys.com/Documentation/KC/latest/API/KnowledgeAPI

Sample Ul Knowledge Agent

Feedback
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Knowledge Agent

_gka.noAnswer(options): Promise

Description: Marks query as the one that do not have valid answer in
knowledge base.

* options
Type: PlainObject

A set of key/value pairs that contains arguments for the RESTful API.

¢ from
Type: Number
Pagination offset.

* size
Type: Number
Pagination page size
* query
Type: String
User typed query string
e categories
Type: String[]
List of categories that are used as context for the current query

For additional information, please refer to the Knowledge API page.

_gka.vote(options): Promise
Description: Records user ratings for the document within a query.
* options

Type: PlainObject
A set of key/value pairs that contains arguments for the RESTful API.

* kblid
Type: String
Knowledge base identifier

e docld

Example

_gkn.noAnswer ({

from: 0O,
size: 10,
query: '"',

categories: []
}).fail(function(error, status) {
console.log(error)
1)

Example

_gkn.like({
docId: ''groupon 22'',
relevant: false

}).fail(function(error, status) {
console.log(error)

1)
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Sample Ul Knowledge Agent

_gka.vote(options): Promise Example
Type: String
Particular document identifier.

¢ relevant (default: true)
Type: Boolean
Whether the search result was relevant.

* query
Type: String
User typed query string.

* categories
Type: String
List of categories that are used as context for the query.

e filters
Type: String[]
List of filters.

Response

* recordid
Type: String[]

Created vote ID

_gka.advancedVote(options): Promise Example
Description: Marks queries that do not have a valid answer in knowledge
base.
. ti _gka.advancedVote({
options likeDocId: 'id2', selection: ['idl', 'id2', id3']
Type: PlainObject 1)

A set of key/value pairs that contains arguments for the RESTful API.
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Sample Ul

Knowledge Agent

_gka.advancedVote(options): Promise

* kbid
Type: String
Knowledge base identifier

e likeDocld

Type: String
Particular document identifier.

selection
Type: String[]
An array of document ID's in search result.

* request (default: ")

Type: PlainObject
Request for the associated search.

° query
Type: String
User typed query string.

e categories
Type: String[]

List of categories that are used as context for the current

query

 filters Type: String[]
List of filters.

For additional information, please refer to the Knowledge API page.

Response

e recordid

Type: String

Created vote ID

Example
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Sample Ul Knowledge Agent

_gka.visit(options): Promise Example
Description: Registers document views.

e options
Type: PlainObject
A set of key/value pairs that contains arguments for the RESTful API.

* kblid
Type: String
Knowledge base identifier

e docld ..
; . _gkn.visit({
Typg. SLlig . e docId: "knowledge",
Particular document identifier. }).fail(function(error, status) {

* query console.log(error)

Type: String Hi
User typed query string.
* categoreis
Type: String[]
List of categories that are used as context for the current query.
o filter
Type: String[]
List of filters.
_gka.rating(options):Promise Example
Description: Registers 5-star rating for the document
* options _gka.rating({
Type: PlainObject kbId: 'knowledgefaq',
A set of key/value pairs that contains arguments for the RESTful API. docId: '550e8400-e29b-41d4-a716-446655440000",
comment: 'This document was very helpful',
¢ kbid rating: 5
Type: String k)5

Knowledge base identifier
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Sample Ul

Knowledge Agent

_gka.rating(options):Promise

e docld
Type: String
Particular document identifier.

e comment
Type: String
Text comment

* rating
Type: String enum (1, 2, 3, 4, 5)
Rating for the document

Response
* recordid

Type: String

Created vote ID

_gka.addRating(options): Promise

Description: Add rating & comment to an existing vote.

* options
Type: PlainObject

A set of key/value pairs that contains arguments for the RESTful API.

e voteld
Type: String
Particular vote identifier

¢ comment
Type: String
Text comment

_gka.addRating({

voteId: 'vote id',
comment: 'some comment',
rating: 5
1)

Example

Example
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Sample Ul

Knowledge Agent

_gka.addRating(options): Promise Example
* rating
Type: String enum (1, 2, 3, 4, 5)
Rating for the document

Response
Not Provided

_gka.addComment(options): Promise Example
Description: Registers document views.

* options
Type: PlainObject
A set of key/value pairs that contains arguments for the RESTful API.
e voteld

_gka.addComment ({
Type: String

voteld: 'vote id', comment: 'some comment'
Particular vote identifier. 1)

¢ comment
Type: String[]
Comment body

Response

e recordid
Type: String

Created vote ID
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Sample Ul Knowledge Agent

Promise Object

The object returned by all methods of _gka variable implements the Promise interface, giving them all
the properties, methods, and behaviour of a Promise (see jQuery Deferred for more information). It
represents a value that may not be available yet.
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Knowledge Agent

promise.done(doneCallbacks [, doneCallbacks ]): Promise

Description: Add handlers to be called when the Deferred object is
resolved.

* doneCallbacks
Type: Function(response, status)
A function, or array of functions, that are called when the Deferred is
resolved.
* doneCallbacks
Type: Function(response, status)

Optional additional functions, or arrays of functions, that are called when
the Deferred is resolved.

promise.fail(failCallbacks [, failCallbacks ])): Promise

Description: Add handlers to be called when the Deferred object is
rejected.

* doneCallbacks
Type: Function(error, status)
A function, or array of functions, that are called when the Deferred is
rejected.
* doneCallbacks
Type: Function(error, status)

Optional additional functions, or arrays of functions, that are called when
the Deferred is rejected.

promise.always(alwaysCallbacks [, alwaysCallbacks ]): Promise
Description: Add handlers to be called when the Deferred object is either
resolved or rejected.

» doneCallbacks
Type: Function(response|error, status)
A function, or array of functions, that is called when the Deferred is

Example

promise.done(function(response, status) {
alert('ajax call succeeded');
console.log(response);
console.log(status)

1)

Example

promise.done(function() {
alert('ajax call succeeded');

}).fail(function(error, status) {
alert('ajax call failed');
console.log(error);
console.log(status)

1)

Example

promise.always (function(responseOrError, status) {

alert('ajax call completed with success or error callback
arguments');

console.log(responseOrError);
console.log(status)
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promise.always(alwaysCallbacks [, alwaysCallbacks ]): Promise Example

resolved or rejected.

* doneCallbacks )
Type: Function(response|error, status) }i

Optional additional functions, or arrays of functions, that are called when
the Deferred is resolved or rejected.

promise.state(): String
Description: Determine the current state of a linked Deferred object.

The .state() method returns a string representing the current state of the Deferred object. The Deferred object can be in one of three states:
* pending: The Deferred object is not yet in a completed state (neither "rejected" nor "resolved").

» resolved: The Deferred object is in the resolved state, meaning that the doneCallbacks have been called (or are in the process of being called).

* rejected: The Deferred object is in the rejected state, meaning that the failCallbacks have been called (or are in the process of being called).
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Ul Widgets

Overview

The Sample Ul is based on independent and easily configurable components. Each component is a
View in term of Backbone.js and may depend on Knowledge Agent and other 3rd party libraries. All
the dependencies are managed by Require)S in AMD-style.

When using widgets, the path to their file must be written using the .define function, which exports a
constructor function to the current context. The last step is to create object (new
Constructor(options)) based on this constructor and call .render() method. Some widgets (in
particular : Categories, Result and Document widgets) fetch data from the server and, in this case,
.fire() method must be called before .render() method. Furthermore, each widget has public object
settings, with stored widget configuration, based on constructor arguments.

You can find a Basic API on the Backbone documentation page.

Components

Search Widget

The Search widget displays the standard Search bar and has a custom placeholder and optional Clear
button.
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Description: constructor for search widget.

SearchWidget([options])

el (default: '#_gk-_wd-_sr')
Type: String

Selector for DOM element in which the current widget will be inserted

placeholder (default: )
Type: String
Placeholder for search input

buttonText (default: 'Search')
Type: String
The text in search button

showClearButton (default: true)
Type: Boolean
Whether to show or not Clear button

query (default: )
Type: String
Typed text for search input

categories (defult: [1)
Type: String[]
Context categories for autocomplete

searchButtonClickEventListeners

Type: Function(Element element, PlainObject options)[]
Functions to be called on Search button click

¢ element
Type: Element

An element in the Document Object Model (DOM)

e options
Type: PlainObject

A set of key/value pairs that contains data for listeners.

e query

Example

Search

Search Widget Interface

new SearchWidget ({

placeholder: 'What are you looking for?',

showClearButton:

searchButtonClickEventListeners:

true,

console.log('Search button clicked')

i

}) .render();

[ Search

Search Widget Interface

new SearchWidget ({

placeholder: 'Type your question',

showClearButton:
}).render();

false

[function (element, options)
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SearchWidget([options]) Example

Type: String
User typed query string.

e clearButtonClickEventListeners
Type: Function(Element element)[]
Functions to be called on Clear button click

¢ element
Type: Element
An element in the Document Object Model (DOM)

.render(): SearchWidget
Description: renders the view template and updates this.el with the new HTML.
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Result Widget

The Result widget displays the search results and has optional pagination and optional embedded
blocks of categories. this widget is dependent on the _gka.search() method in Knowledge Agent.
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ResultWidget([options])

Description: constructor for results widget.

el (default: '#_gk-_wd-_rs')
Type: String
Selector for DOM element in which the current widget will be inserted

resultType (default: 'SEARCH")
Type: String enum ('SEARCH', 'TOP', 'BROWSE')
Base type of the widget

size (default: 10)
Type: Number
Number of documents in result list

showAnswer (default: true)
Type: Boolean
Whether to show or not answers in document

charactersinAnswer (default: 250)
Type: Number
Number of character in answer before "more" link appears

pagination (default: true)

Type: Boolean

Whether to show or not pagination panel. Works only with resultType=
'BROWSE'

filters
Type: PlainObject[]
Array of custom filters for search.

» fieldld
Type: String
Identifier of the field which need to be filtered (segment equal
"premium")

* operation
Type: String enum ("equal", "gt", "It", "range", "regexp", "enum")

Whal's & 401{k) plan?

Example

A SDN[K] plany i 3 Lae-quaiined reframent plan that sloen smplayeel (a0 buiineid oeney) 0wy for retrement with pre-tis
confrbubions that defer part of Ter pay. & 200 (K] plan may aliow T employsr by make baedsduchible contribubons £

Who can esiablish a 401(k) plan?

Ay soke proprietor, pafnership, corporation or subchapter 5 and certamn ronprofit organizations can estabish a. 40 1(kj) plan. Siate
W WA QOVETTITETRS e [IONICY TOm PG 451 (k) plans., but tene are other types of retrement plans that m

Categories

Hane Mortgags

Result Widget Interface

new ResultWidget ({

size: 2,
showAnswer: true,
charactersInAnswer:

pagination: true,
highlighting: false,

moreLinkClickEventListeners:
console.log('Document selected')

}).fire().done(function(response, widget) {

widget.render()

1)

o Equty Bt

250,

Home Equity Ratey I Senvicen

What are redemption codes and how do they work?

When and how will my goods arrnive?

Result Widget Interface

[function (element, options) {
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ResultWidget([options]) Example

Expression operator (segment equal "premium")

* value
Type: not defined
Value for expression (segment equal "premium")

e morelLinkText (default: 'more')
Type: String
Allows to override default text in "more" link

e showNoAnswerButton
Type: Boolean
Whether the "No relevant results" button will be shown

¢ noAnswerButtonText (default:"No relevant results")
Type: String

Localizable button label (SO ARG

size: 2,
* noAnswerClickedText' (default: "Thank you for your feedback!") :Eg%gi‘g;g;i;z?s?élse
Type: String . . }).fire().done(function(response, widget) {
Localizable message after the "No relevant results" button has been widget. render ()
clicked 1)

* noMatchesText (default: "No matches found.")
Type: String
Localizable message if search result contains zero documents

* documentClickURI (default: function () { return 'javascript:;' })
Type: Function()
URI after "more" button has been clicked

¢« documentClickListeners
Type: Function(Element element, PlainObject options)[]
Functions to be called on "more" link click

e element
Type: Element
An element in the Document Object Model (DOM)
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ResultWidget([options])

e options

Type: PlainObject

A set of key/value pairs that contains data for listeners.

* id
Type: Number
Document identifier
question
Type: String
Question in document
answer
Type: String
Answer in document

e noAnswercClickListeners
Type: Function(Element element)[]
Functions to be called on "No relevant results" button click

.fire(): Promise

Description: fetch data from the server according to passed options.

* query (default: )
Type: String
User typed query string

» categories (default: [])

Type: String[]

List of categories that is used as a context for the current query
» filters (default: [])

Type: String[]

Filters that will be passed. Works anly with resultType='SEARCH'

.render(): ResultWidget

Description: renders the view template from fetched data and updates this.el with the new HTML

Example
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Categories Widget

The Categories widget displays categories and is similar to the categories block in the Result widget
or the Document widget however, in the Categories widget, only the categories are stored. The
Categories widget is dependant on the _gka.getCategories() method in Knowledge Agent.
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CategoriesWidget([options]) Example
Description: constructor for categories widget.
* el (default: '#_gk-_wd-_cat')
Type: String
Selector for DOM element in which the current widget will be inserted
* numberOfColumns (default: 3)
Type: Number
Number of columns in panel categories
. f.lilterescic_att[e]gories (default: []1) Home Martgage Tax Dacuments
ype: String
Array of id's for categories which should be rendered. Empty array means moblie services frequently asked questions Online check images
that all of fetched categories will be rendered. Home Equity Basics Getting an auta loan
» categoryClickURI (default: function () {return 'javascript:;'}) My Spending Report with Budget Watch Buying
Type: Function()
URI after category has been selected (clicked) Categories Example
» categoryClickEventListeners
Type: Function(Element element)[] . )
. : new CategoriesWidget({
Functions to be called after particular category selected T Ss 4,
. element categoryClickEventListeners: [function (element, options) {
Type: Element console.log(options.id)
' . , 1
An element in the Document Object Model (DOM) }).fire().done(function(response, widget) {
e options widget.render()
Type: PlainObject H;
A set of key/value pairs that contains data for listeners.
* id

Type: Number
Category identifier

°* name
Type: String
Category name
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CategoriesWidget([options]) Example

» categoriesNotFoundText (default: "No linked categories found")
Type: String
Localizable message if no linked categories found

.fire(): Promise
Description: fetch data from the server.
.render(): CategoriesWidget

Description: renders the view template from fetched data and updates this.el with the new HTML.
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Document Widget

The Document widget displays documents and can have an optional feedback block, a help button,
and an embedded block of categories that are associated to the document. The Document widget is
dependant on _gka.getFullContent() and _gka.like() methods in Knowledge Agent.
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DocumentWidget([options]) Example
Description: constructor for document widget.
Wha 8 & rate lock?

+ el (default: '#_gk-_wd-_doc’) pritemsel gt ep it bk s i
Type: Str| ng ":'l‘.' rehr:c- Wl:l.:ﬂ.':rr_.)"! L .-:l;-' ?mrﬂwﬂ:!t"m;a:}:::xwd H-:I:r:.f: RN N W Bppi aSon generally
Selector for DOM element in which the current widget will be inserted T e

Whathat | lourd & rebresn - (210 | e ——

* feedbackType (default: 'BINARY")
Type: String enum (‘NONE', "BINARY") Document Widget Example 1
Style of rendering the feedback block

» commentTrigger (default: 'negative’) .

Type: String enum ('negative’, 'positive’, both) new DOCUNenthqgt?t({ .
When comment block should appear (for example when 'negative’, the ‘:gggggzggbe.kf‘g‘&“higg?faq—“ ,
comment block will be shown just after a negative vote) el Are . WhettE T T e S el e
. feedback showHelpButton: true,
. i ; helpButtonText: 'I need more help',
Type: PlainObject feedbackSelectEventListeners: [function (element, options) {

modified (default: 'Modified")
Type: String
Localizable message for modification date tooltip

views (default: 'Views')
Type: String
Localizable message for views number tooltip

rating (default: 'Rating')
Type: String
Localizable message for rating tooltip

question (default: Was this helpful?)

Type: String

Localizable message

defaultAnswer (default: Thank you for your vote.")
Type: String

Localizable message

noCommentAnswer (default: 'Thank you for your vote.')

console.log(options. feedbackType);

console.log(options.rate);
Kl s
helpButtonClickEventListeners:

console.log(options.document.id);

13l
1) .fire({
kbId: 'knowledgefaq',
docId: 'knowledgefaq 66'
}) .done(function(response, widget) {
widget.render()
1)

Whal i & rale bock?

A rEE 30K el y0u PRI O INANoE Maike NUOUana Ml S50 STe0 your Mleresl File fange Tou CEN CRoEE 10 0K oF Rl
W IR NPl FaDE range O [N G008 3N B yOu 000 Nal Inkere sl ake range reMman vadabie 10 yOu 105 3 B penod of Bme B
ere 3e N Sulisequent DNanQes 10 yOour Dan 3yl Meres e fange & 00k, M NDeretl FNe Tange O FOLF SPPECION DEne iy
resTans e same . Finsre are changes to your oan . your Sngl nmerew rale of Chrsing may De SiTerent

Document Widget Example 2

[function (element, options) {
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DocumentWidget([options])

Type: String
Localizable message

* submitAnswer (default: 'Thanks, your feedback has been
submitted.')
Type: String
Localizable message

e commentPlaceholder (default: "Why wasn't this helpful?')
Type: String
Localizable message

¢ buttons
Type: PlainObject

e yes (default: 'Yes')
Type: String
Localizable message

e no (default 'No")
Type: String
Localizable message

e submit (default: 'Submit')
Type: String
Localizable message

¢ noComment (default: 'No Comment')
Type: String
Localizable message

* showHelpButton (default: true)
Type: Boolean
Whether or not to display help button

¢ helpButtonText (default: 'l need more help.')
Type: String
Text in help button

Example

new DocumentWidget ({
documentId: 'knowledgefaq 4',
feedbackType: 'NONE',
showHelpButton: false

}).fire({
kbId: 'knowledgefaq',
docId: 'knowledgefaq 66'

}) .done(function(response, widget) {
widget.render()

})<br>

[[File:Document3.png|thumb|center|400px |

Document Widget Example 3]I<br>

new DocumentWidget ({
documentId: 'knowledgefaq 4',
feedbackType: 'RATING',
feedbackText: '',
showHelpButton: true,
helpButtonText: 'Help me'

1) .fire({
kbId: 'knowledgefaq',
docId: 'knowledgefaq 66'

}) .done(function(response, widget) {
widget.render()

)
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DocumentWidget([options])

 showHelpAttachments (default: true)
Type: Boolean

Whether or not to display document attachments
« feedbackClickListeners
Type: Function(Element element, options) []
Functions to be called after feedback selected
* element
Type: Element
An element in the Document Object Model (DOM)
* options
Type: PlainObject

A set of key/value pairs that contains data for listeners.

¢ document
Type: PlainObject
Current document

* rate
Type: Number
Chosen rate

- feedbackType
Type: String
Current feedbackType

* helpButtonClickListeners
Type: Function(Element element, options)[]
Functions to be called after help button clicked
* element
Type: Element
An element in the Document Object Model (DOM)
* options
Type: PlainObject

Example
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DocumentWidget([options]) Example

A set of key/value pairs that contains data for listeners.

e document
Type: PlainObject
Current document

¢ localLinkClickEventListeners
Type: Function(Element element)[]

Functions to be called after help local link in the document clicked

* element
Type: Element
An element in the Document Object Model (DOM)

.fire(options): Promise

Description: fetch data from the server according to passed options.

e kblid

Type: String

Knowledge base identifier
e docld

Type: String

Document identifier

.render(): DocumentWidget

Description: renders the view template from fetched data and updates this.el with the new HTML.
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Filter Widget

The filter widget displays one single filter item depending on the passed configuration options and
can be configured for visualization (timepicker, string input, number input).
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FilterWidget(options)

Description: constructor for filter widget.

* el (default: '#_gk-_wd-_f1')
Type: String
Selector for DOM element in which the current widget will be inserted

. type (default: 'INPUT")

Type: String enum ('INPUT', 'DROPDOWN', 'BETWEEN')
Basic filter type

e field (default: 'id")
Type: String
Document field on which the result will be filtered

* fieldAlias (default: field)
Type: String
The text that will be shown near the input(s)

* options
Type: PlainObject
A set of key/value pairs which contain additional configuration of the
widget
Widgets with different type expect different set

* valueChangeEventListeners (default: [])
Type: Function(Element element, options)[]
Functions to be called after value changed

¢ element
Type: Element
An element in the Document Object Model (DOM)

e options
Type: PlainObject
A set of key/value pairs that contains data for listeners

Example

1D: [5E|EG[ Ill
ID: |=

(1) Date: | =

Confidence: [ 09

Created: to |2014-09-12

= w© | 0.9 =

(2) Confidence: [ o4

Filter Widget Example

// Example (1)
var filterWidget = new FilterWidget({
type: 'INPUT',
field: 'created',
fieldAlias: 'Date’,
options: {
inputType: 'DATE',
operator: 'GREATER EQUAL',
Be
valueChangeEventListeners: [function (element) {
console.log('date changed')
1

1)

//Example (2)
var filter2 = new FilterWidget({
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FilterWidget(options)

"INPUT" type options (default)
Rendering based on HTML tag:

<input type="text | number">

* inputType (default: 'STRING')
Type: String enum (‘STRING', 'NUMERIC', 'DATE')
Determines which basic type wiil be used for <input>

* operator (default: 'EQUAL")
Type: String enum ('LESS', 'LESS_EQUAL', 'GREATER',
'GREATER_EQUAL', 'EQUAL")

¢ value (default: )
Type: String

"DROPDOWN" type options
Rendering based on HTML tag:

<select>

* header (default: 'Select')

Type: String

First, default, empty-behaviour <option>
e values (default: [1)

Type: String[]
Other, non-empty <options>'s

¢ value (default: )
Type: String

Current value. If value in an instance of values, particular <option>

obtains selected attribute.

1)

Example

type: 'BETWEEN',
field: 'confidence',
fieldAlias: 'Confidence',
options: {
separator: 'to',
inputType: 'NUMERIC',
from: 0.4,
to: 0.9
}!
valueChangeEventListeners: [function (element, options)
console.log('one of two values changed')
3
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FilterWidget(options)

"BETWEEN" type options
Rendering based on two of the following HTML tags:
<input type="text | number">
* inputType (default: 'DATE")

Type: String enum (‘NUMERIC', 'DATE")
Determines which basic type wiil be used for <input>

* separator (deafult: 'to')

Type: String

The text separator between two <input>'s
e from (default: )

Type: String | Number
First value

e to (default:)
Type: String | Number

Second value

.render(): FilterWidget

Description: renders the view template and updates this.el with the new HTML.

filterJSON(): Filter

Description: returns compiled filter object related to current widget that can be used in /search API.

Example
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CSS Customization

All widgets have some basic CSS defined and built-in, however Styles can be managed though the
browser debugger or easily overridden in a custom CSS file. HTML tags separation is based on classes
and all classes used in the Sample Ul are divided into different namespaces. For example, widget-
classes have a _gks-_wg- prefix. Non-widget classes only use the _gks- prefix.

Filters

The Result widget supports extensions with custom filters and has a filters property, which is an array
of standard objects.

Default filters are configurable along with other Knowledge Base information however only one
default filter can be configured per language. Filters can be based on the basic fields of the
knowledge article and custom fields (properly defined custom fields only).

All filter criteria is applied using AND logic (for example, createddate > 20140101 00:00:00 AND
segment = "premium").

The Result widget only supports the standard syntax and does not know which filters
are enabled in the Knowledge Base.
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Adding Business Insight

Overview

Some customizations are available when applying different routing strategies to different groups of
customers.

Customer categorization in proactive events

1. In Custom Fields, create a Value for a particular Knowledge Base.

knowledgeFAQ <X VALUE <
Celete Purge Ogptions — o
= VALUE
Mamae *
L o Display Marme * i ]
WnowledgeF A
Question business value
Description [i ]
Type* i
KnowledgeF A0
String -
Languiages * n Default Vabke n
Englsh, default
FrEnen + Allow empty
German
+

w Knowledge base 1s actve

» Knowledge base is public

Custom Fields i ]
Question business value (VALLE, strang)

Creating a Value

2. Store a business value in Custom Fields for each question in Knowledge Base:
POSITIVE - Customer who needs additional information or help after observing the data. This could be
a new client who is looking to purchase a service or request additional services.
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NEGATIVE - Customer who searched the info and refused service or found ways to create a claim.
NEUTRAL - No potential positive or negative business impacts.

Edit document v {ghs_super, 201 50407 1236) ~ | English w
Cmr-sm Ccucass
walue (STRING)

POSITIVE |

Business Value
3. This Custom Field and its Value is stored in the Knowledge Ul page as a hidden attribute.

4. Customize the DLS file to support proactive events on opened documents and attach the value of the
Custom Field to the interaction. For example, when clicking the "I need more help" button we can
invoke a new event and attach all required information to the interaction:

<event id="Help" name="GKnowledge Help">
<trigger name="HelpTrigger" element=
"DIV. gk- wd- doc-help-bt A" action="click" url="" count="1"/>
<val name="gks question" value="$('#searchContent').val()"/>
<val name="gks kbId" value="'knowledgefaq'"/>
<val name="gks session" value=
"window.localStorage.getItem('sessionId')"/>
<val name="gks lang" value="'en'"/>
<val name="gks value" value=
"window.localStorage.getItem('businessvalue')"/>
</event>

5. Add a new business rule to invoke a new proactive chat on this event:

rule "Rule-101 Provide Help"
salience 100000
agenda-group "levelO"
dialect "mvel"
when
$eventl: Event(eval($eventl.getName().equals('Help')))
then

sendEvent ($eventl, ed, drools);
end

6. During parsing, the new variable and its value are obtained from this interaction we can route the
interaction using different branches of the business strategy:
NEUTRAL - route via common strategy
NEGATIVE - route with high priority to specific group with escalation specialists
POSITIVE - route with high priority to marketing specialists
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Implicit User Feedback

Overview
To improve search quality, gather implicit user feedback via Proactive Engagement integration.
For example, sending additional implicit user feedback automatically in cases such as:

e Customer executed the search, saw search results and left search result page in less then X seconds - >
Negative feedback published for all documents in the result set.

Customer executed the search, saw result, opened the document and left the page in less then X
seconds -> Negative feedback published for particular document.

Customer executed the search, saw result, opened the document and remained on the page for X
minutes -> Positive feedback to be published for the document.

Customer executed the search, saw result, opened the document and opened attachment to the
document-> Positive feedback to be published for the document.

Customizing the Script and reconfiguring the routing strategy

1. Add additional JavaScript code to the Web Monitoring Agent on the front-end page to monitor
described events.
For example:

1. Create a small JavaScript function to wrap sending feedbacks:

function feedbackSender
(decision, behavior, timeoutSeconds){
this.decision = decision;//positive,negative
this.timeoutSeconds = timeoutSeconds;
this.behavior = behavior;//less,more,equal
this.openTime = null;
this.sendPositiveFeedback = function(){
console.log("Positive feedback");
}
this.sendNegativeFeedback = function(){
console.log("Negative feedback");
}
this.sendFeedback = function () {
switch (decision) {
case "positive":
this.sendPositiveFeedback();
break;
case "negative":
this.sendNegativeFeedback();

break;
default:
console.log("Sorry, we are out of "
+ this.decision + ".");
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}
}

2. Add methods to monitor timeout:

this.onOpenPage = function () {
this.openTime = new Date();
b

this.onLeftPage = function () {
switch (behavior) {
case "less":
if ((this.openTime)&&(((new Date())
- this.openTime) < this.timeoutSeconds * 1000)) {
this.sendFeedback();
}

break;
case "more":
if ((this.openTime)&&(((new Date())
- this.openTime) > this.timeoutSeconds * 1000)) {
this.sendFeedback();
}

break;
case "equals":
if ((this.openTime)&&(((new Date())
- this.openTime) == this.timeoutSeconds * 1000)) {
this.sendFeedback();

}
break;
default:
console.log("Sorry, we are out of "
+ this.behavior + ".");

}
}

3. Implement provided business cases using this function. For example:

* Case 1: Customer executed the search, saw search results and left search result page in less
then X seconds - > Negative feedback published for all documents in the result set.

firstCaseFeedback = new feedbackSender
('negative', 'less',5)
firstCaseFeedback.sendNegativeFeedback=function()

_gt.push(['event', {eventName: 'Feedback',
gks Reason: 'negative', gks docIds: strArr,
gks sessionId: gks sessionId,

gks query: gks query}l);

$(window).on('hashchange', function(e){

if (window.location.hash.indexOf('/search/")
>= 0) {

firstCaseFeedback.onOpenPage();

arr=[];

var $resultDiv = $('. gk- wd- rs');
$resultDiv.ready(function () {
$resultDiv.each(

function(index, a) {

var basicId = $(a).attr('id');
arr.push(basicId.substring(18, basicId.length))
}

)’
}
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strArr = JSON.stringify(arr);

gks query = $('#searchContent').val();
gks sessionId = window.localStorage.getItem
('sessionId');

b

s

$(window) .on( 'hashchange', function(e){
var oldURL = e.originalEvent.oldURL;
if (oldURL.indexOf('/search/') >= 0) {
firstCaseFeedback.onLeftPage();

b

b

s

Case 2: Customer executed the search, saw result, opened the document and left the page in

less then X seconds -> Negative feedback published for particular document.

secondCaseFeedback = new feedbackSender
('negative', 'less',10)
secondCaseFeedback.sendNegativeFeedback=function()

{
_gt.push(['event', {eventName: 'Feedback',
gks Reason: 'negative', gks docIds:
gks docId, gks sessionId: gks sessionId,
gks _query: gks query}l);
}

$(window).on('hashchange', function(e){

if (window.location.hash.index0f('/document/")
>=0) {

gks _query = $('#searchContent').val();

gks sessionId = window.localStorage.getItem
('sessionId');

gks _docId = window.location.hash.substr
(window.location.hash.length - 36);

secondCaseFeedback.onOpenPage();

}
s

$(window) .on('hashchange', function(e){
var oldURL = e.originalEvent.oldURL;
if (oldURL.indexOf('/document/') >= 0) {
secondCaseFeedback.onLeftPage();
}

1}

Case 3: Customer executed the search, saw result, opened the document and remained on
the page for X minutes -> Positive feedback to be published for the document.

thirdCaseFeedback = new feedbackSender
('positive', 'more',20)
thirdCaseFeedback.sendPositiveFeedback=function()

{
~gt.push(['event', {eventName: 'Feedback’,
gks Reason: 'positive', gks docIds:
gks docId, gks sessionId: gks sessionId,
gks query: gks query}l);
}

thirdCaseFeedback.onOpenPage=function(){
thirdCaseFeedback.openTime = new Date();
setTimeout (function()

{thirdCaseFeedback.onLeftPage();},
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(thirdCaseFeedback.timeoutSeconds+1)*1000);
}

$(window) .on('hashchange', function(e){

if (window.location.hash.indexOf('/document/"')
>= 0) {

gks query = $('#searchContent').val();

gks sessionId = window.localStorage.getItem
('sessionld');

gks docId = window.location.hash.substr
(window.location.hash.length - 36);

thirdCaseFeedback.onOpenPage();

b
s

2. Create a business rule to invoke interaction on this event:
rule "Rule-101 Feedback"
salience 100001
agenda-group "levelO"
dialect "mvel"
when

$eventl: Event(eval($eventl.getName().equals
('Feedback')))

then
sendEvent($eventl, ed, drools);

end
3. Modify the strategy to route the interaction invoked by these events in a separate branch.
4. Use modules to send REST requests in these branches to publish feedback to the Knowledge server:

Positive feedback:

POST

URL: http://<host>:<port>/gks-server/vl/feedback/

knowledgefaq/documents/<docId>/

vote?relevant=true&sessionId=<sessionId>

BODY: {"query":"<query>"}

Negative feedback:

POST

URL: http://<host>:<port>/gks-server/vl/feedback/

knowledgefaq/documents/<docId>/

vote?relevant=false&sessionId=<sessionId>
BODY: {"query":"<query>"}
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Improving Contact Us Form

Overview

You can utilize Knowledge Center capabilities to assist customers as they fill out forms on your
corporate web site (for example, when providing feedback). This integration provides suggested
answers to a customer's query by utilizing the Category selections, and keywords used in the
Subject line. This simple guide will show you how Knowledge Center can be easily integrated into a

Webform.

Webform integration

Before integration

Integrate the knowledge with a simple feedback form:
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HTML

<div class="container">
<div class="main">
<div>
<label>
Category <br>
<select class="categories"></select>
</label>
</div>
<br>

<div>
<label>
Subject <br>
<input autocomplete="off" class="search" placeholder=
"What is knowledge Center?" type="text">
</label>
</div>
</div>

<!-- MAIN DIV -->
<div class="gkc-webform"></div>
</div>

Java Script

$(document) .ready(function () {
webform.init({
host: 'http://%your server host%/gks-server/vl',
categories: {

'Finance': "knowledgefaq',
'Account': "knowledgefaq',
'Signing in': 'knowledgefaq',
'Buying': "knowledgefaq',
'Shipping & tracking': "knowledgefaq',
'Booking trips ': 'knowledgefaq',
'Gifts ': "knowledgefaq',
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'Mobile ': "knowledgefaq',
'"Email subscriptions ': "knowledgefaq',
'Restaurant reservations ': 'knowledgefaq'
}
1)

webform.markkKbsDropdownWithMap('.gkc-kbs');
webform.markSearchInput('.gk-search');

})

Java Script
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Genesys Webform - Moziila Firefox

Cendsys Weblanm

& Bl hormed ik o/ Develapmentinowledgecomponentsfintegrationifweble - & $ O # ~» m - 5. B & @ =
Catogory v What I5 Genesys Knwiedge Cemes?
Finance
Coiviniys Knowisdos Conter allows you 1o make the best use ol
Euh_lﬂf-l your enieiprse knowiedge by capiunng, sionng, and
— distributing it wherever it is needed Bull by Genesys, this

prosiact seamiesshy MegIaies o v Genesys poducts 1o
provce configurason via Genesys Admnisiraio, reporing and
bas: analytics wia Pulle ahd agenl deskion RISgrason 10
Waorkspace Deskiop Ediion

¥ Do the Knowledge Cenier CMS and the Knowliedge Cemes
Server use the same dala?

b Why 0o | need e Genesys Knowiedge Center CAES?

Do Ay of these address you qUeSHon™ ¥

Example of simple integration.
Integration steps

1. Add all files (1 .css and 1 .js) from folder <knowledge_center_server_root>\server\tools\webform
to site context. Core .js file applies only to rendering results ("Suggestions" window in the above
figure).

2. Configure added script through window.webform variable:

* Use webform.init() method to pass general options

¢ Use webform.markKbsDropdownWithMap() to mark a specific <select> tag as a Categories
selector.

Use webform.markSearchinput() to mark a specific <input> tag as to which Knowledge Center is
performing the search.

Examples of integrations can be found in <knowledge center _server_root>/server/
tools/webform/example folder.

After integration

As the result of this integration you now have a feedback form that pro-actively looks up the
knowledge related to a customer inquiry and displays possible suggestions to the customer.
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WebForm can also contain a more complex demo based on Semantic-Ul CSS-
framework. See a complex integration at <knowledge center _server_root>/server/
tools/example/complex.html

_

o Pl e a2k oy Development s bl ormgindeds eml +C 4 B #: ms T B B E
oy Pk Ligpriars,
Cisgirr

* ‘Wwhat h Genesyy Knowiedpe Center ™

et Cepreevyn Knowiecipe Coanter allown you to make the
bt e of wolr enter priae Enowiedge By capiuring.

Saafert nbaring, wnd dintributing | vt eeers it s nooded Buii
by Gervesps TR g D dndunl | Sedamibeidy snDings sl 10
el vy el 1S 10 ok Oofilfgior Bion
vis Doy, Acdmuirdair stor, repeerting s b
arabvic i Pulie snd spenl denkdiop inlegr sbon ln
Workvpace Dendciop Edetion

Vet i Knowiedips Canter i

MruLags body

¢ Do the Krowledge Center CMS and the
Krpwviedige Conter Sereer v the ames data’

¢ Why do | nead the Ganesys Knowledge Center
[# 05

[ T p————— L

Knowledge suggestions displayed

WebForm Widget API

Use the following information to integrate the WebForm Widget API on your html page.
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webform.initialize(options) Example

webform.init({

° Description: Conﬁgure the WebForm W|dget host: ' http ://192.168.66.176: 9095/9'(5 -server/vl' o
categories: {
» options Type: PlainObject A set of key/value pairs that configure the 'Finance': ‘financefaq’,
Agent. "Account': 'accounting',
'Signing in': 'webfaq',
* host Type: string A network host where Knowledge API is stored. 'Gifts ': 'knowledgefaq',
'Mobile ': 'mobilefaq’,
» categories Type: PlainObject A map of the predefined labels of '"Email subscriptions ': 'webfaq'
categories. Keys are a labels and values are knowledgebase IDs. }
5D
webform.markKbsDropdownWithMap(selector, callback) Example
* Description: Create widget-dependent dropdown based on passed
selector of <select> tag. This method uses categories passed to the
.initialize method.
webform.markkbsDropdownWithMap('.gkc-kbs', function () {

» selector Type: jQuery Selector A string containing a selector $('.gkc-kbs").dropdown();

expression to match elements against. 1)
¢ callback Type: Function() A function to be called after main

operations.

webform.markKbsDropdown(selector, callback) Example

* Description: Create widget-dependent dropdown based on passed
selector of <select> tag. This method does not use categories passed

to the .initialize method. It will load knowledge bases with labels

webform.markkbsDropdown('.gkc-kbs', function () {
directly from the Knowledge API.

$('.gkc-kbs').dropdown();
1)

» selector Type: jQuery Selector A string containing a selector
expression to match elements against.

Genesys Knowledge Center Developer's Guide 84



Sample Ul Improving Contact Us Form

webform.markKbsDropdown(selector, callback) Example

e callback Type: Function(kbs) A function to be called after main
operations.

webform.markSearchinput(selector) Example

* Description: Create widget-dependent search input based on passed
selector of <input> tag.
webform.markSearchInput('.gk-search');
* selector Type: jQuery Selector A string containing a selector
expression to match elements against.

webform.getKbs(callback) Example

* Description: Retrieves knowledge bases from the Knowledge API. webform.getKbs (function (kb) {

» callback Type: Function(kbs) A function to be called after knowledge console. log (kb)
bases have been loaded.

webform.makeSearch(query, callback) Example

» Description: Searches documents from the Knowledge API based on
query. webform.makeSearch('What is Knowledge Center?', function

. . (documents)
e query Type: string User typed query string console.{og(documents)

e callback Type: Function(documents) A function to be called after H
documents have been loaded.
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